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目的 

干渉 SAR時系列解析の SBAS法の操作方法を説明します。 

2枚の画像で処理を行う DInSAR(差分干渉 SAR)解析でも地面の変動を捉えますが、時系列干渉

SAR解析では変動の時間的変化を監視することを目的とした解析手法です。また、多数の画像を

使用するため、処理中にノイズや大気の影響を考慮し低減します。 

SBAS法の特徴としては、差分干渉 SAR処理と同様にフィルタ処理や干渉画像のアンラップ処理

を行います。複数のペアから得た位相情報から、大気による遅延の位相成分と高さの残差による位

相成分を除去し、平均速度と高さを算出します。また、変動を算出するモデルは線形および非線形

の選択が可能です。 

SARscape5.7より E-SBAS処理が追加されましたが、本書では従来からの SBAS法の処理につい

て記載いたします。 

 

利用バージョン 

本マニュアルの操作は、SARscape 6.1と ENVI 6.1を使用します。 

 

使用データ 

本チュートリアルでは、Sentinel-1（TOPSARモード、アセンディング）データを使用します。デ

ータの観測期間は、2015年 4月 30日から 2019年 6月 14日までの約 4年間となります。観測範

囲は、神奈川県横浜市周辺のエリアとなります。 

 

 

図 1 処理範囲(Google Earth) 
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事前準備 

ENVI の Preferences設定と SARscapeの Preferences 設定を行います。 

 

ENVI Preferences 設定： 

File → Preferences → Directories → Input/Output/Temporary Directory へ使用するフォルダ

の設定を行います。 

 

SARscape Preferences設定： 

Toolbox → SARscape → Preferences → Preferences specific → Load Preferences 

Load Preferencesにて使用するデータに適切な設定を指定してください。今回は「Sentinel 

TOPSAR(IW-EW)」を選択してください。 

各設定項目について以下表へ説明を記載します。 

 

表 1 Preference Specific設定 

Load Preferences 項目 説明 

General  入力データタイプに合わせて特に調整されていない、一般的

なパラメータ設定です 

UHR (better than 1m) 1m/pixel以下の高解像度データに適しています 

VHR (better than 3m) 3m/pixel以下の高解像度データに適しています 

VHR (better than 6m) 6m/pixel以下の高解像度データに適しています 

HR (better than 10m) 10m/pixel以下の高解像度データに適しています 

MR (between 10m and 30 m) 10m~30 m/pixel の高解像度データに適しています 

LR (coarser than 30m) 数十 m~100m/pixelの中解像度データに適しています 

Interferometry Low Coherence コヒーレンスが低いまたはクロスコリレーションを使用して

コレジストレーションを行う場合に画像内に目立つフィーチ

ャが制限されている干渉データペアに適しています 

Wrong Orbital Data 軌道パラメータの信頼性が低い干渉データセットまたはコレ

ジストレーションのマルチテンポラル振幅シリーズに適して

います 

TanDEM-X Bistatic Configuration バイスタティックモードでの Â TerraSAR-X + Â Tandem-Xで

取得された干渉データペアに適しています 

CInSAR ERS-ASAR Interferometry ERSと ASAR によって作成された干渉データペアに適してい

ます 

Sentinel TOPSAR (IW - EW) TOPSAR(IW)モードで取得した Sentinelデータの干渉処理を

実施する場合この設定は必須です 
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Load Preferences 項目 説明 

PALSAR-2 ScanSAR ScanSARモードで撮影された Palsar 2 SLCの干渉処理を実

施する場合この設定は必須です 

TSX ScanSAR ScanSARモードで撮影された TerraSAR-Xの干渉処理を実施

する場合この設定は必須です 

Squinted data Squinted data(PALSAR-1, JAXA SLC配信)の場合この設定は

必須です 
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処理概要 

SBASの処理フローについて、以下図に示します。この処理フローは SARscapeの SBASの処理メ

ニューと同じ順に記載しており、各フローにおける詳細や手順については後続の章において説明し

ます。 

 

 

図 2 処理フロー 

 

 

図 3 SBAS処理メニュー 

 

 

 

 

  

1 - Connection Graph
時間、軌道間距離のベースライン算出

2 - Interferometric Process
干渉画像作成

3 - Inversion: First Step

速度推定(1回目)

4 - Inversion: Second Step
速度推定(2回目)

5 - Geocoding
ジオコーディング
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コネクショングラフ 

SBASを実施する際の最初の必須ステップです。この機能は複数の画像に対して干渉処理を行うた

めの干渉ペアを定義します。この手順では指定された時間および空間的ベースライン値内にあるペ

アを選出し、作成されたコネクショングラフ内で線が繋がっているペアが干渉に使用されます。コ

ネクショングラフの処理終了後には、Auxiliary.smlファイルが出力されます。Auxiliaryファイル

は SBASの処理を管理するファイルです。実行されたステップ、出力されたデータの情報などが含

まれ、本処理以降は Input Fileへ Auxiliaryファイルを選択し処理を進めます。 

 

【操作】 

1. ENVIツールボックス → SARscape → Interferometric Stacking → SBAS → 1 - 

Connection Graph を選択し、ワークフローダイアログを起動してください。 

 

 
図 4 コネクショングラフの設定ダイアログ 

 

2. Input Filesタブ → Input File Listの Browse Files をクリック → ファイルの選択ダイアロ

グから、使用するファイルを Shiftキーを押しながら複数選択し、「開く」をクリックしてく

ださい。 
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図 5 ファイル選択 

 

3. マスタを指定する場合は、Optional Filesにファイルを指定してください。ここで指定する画

像は、Input Filesでも指定されている必要があります。ここで指定したマスタはスーパーマス

タと呼ばれます。スーパーマスタは全ての処理において参照データとなり、このデータを元に

スラントレンジ画像の位置合わせを行います。指定しない場合は SARscapeが全データから一

つスーパーマスタを抽出します。 

 

 

図 6 マスタデータ選択タブ 

 

4. コネクショングラフを算出する際の設定項目は、Parametersタブにあります。データの条件な

どが異なる場合は設定が必要になる場合がありますが、事前準備の SARscape Preference設定

で使用するデータに合ったものを読み込んでいるため、基本的にはデフォルトのままで問題あ

りません。今回の処理も値を変更せずに実行します。 

 

 

図 7 Parametersタブ 
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Parametersタブの Principal Parameters について簡単な説明を以下に記載します。 

表 2 コネクショングラフのパラメータ 

パラメータ名 内容 

Normal Baseline 通常の基線長に対する設定で、センサにも依存しますが、

Critical Baselineの最大 45～50%まで大きくできます。 

Temporal Baseline 時系列のベースラインの閾値を設定する項目です。観測日の間隔

が大きくコネクショングラフが繋がらない場合に調整することが

可能です。 

Degree of Redundancy コネクションに対する Normalと Temporal Baseline の閾値を適

用した後、さらにコネクションの余剰の程度を指定できます。 

Redundancy Criteria 上記を Lowに設定した際に余剰コネクションを削減するための基

準を選択します。 

Max Connections per 

Acquisition 

余剰コネクションを減少させた後に残る各データ接続数の目安で

す。信頼できる速度推定解を得るには 5以上の値が推奨されま

す。 

Allow Disconnected Blocks 取得したデータの一部がメインのコネクションに含まれず、別個

のコネクションブロックになっている場合は、Allow 

Disconnected Blocks オプションを有効にすることで時間的間隔

が開いた別のコネクションも変動の算出に追加することが可能で

す。その補間は第一変動速度推定の処理時に Linearや

Quadraticなどのモデルを適用します。そのため、算出された結

果の変動の信頼性は Allow Disconnected Blocksオプションを無

効にしている時よりも低くなります。 

 

5. Output Filesタブにてフォルダアイコンをクリックし、ファイルの出力先と出力ルート名を設

定し、「Exec」ボタンをクリックしてください。出力ルート名は、処理フォルダ名に使用さ

れ、出力ルート名+_SBAS_processingというフォルダが作成されます。 

 

 

図 8 出力先設定タブ 

 

6. 処理が終了すると、レポートとコネクショングラフが表示されます。グラフには、スーパーマ

スタの表示（黄色のポイント）、入力データの取得日(X軸)の軌道間距離(Y軸)を示すタイムポ

ジションプロットと軌道間距離(Y軸)と入力データの取得日(X軸)を示すタイムベースラインプ
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ロットが表示されます。処理にはコネクショングラフが繋がっているデータを使用します。ま

た、タイムポジションプロットの接続は、一つの接続に対して平均的に約５接続程度あること

が推奨されます。 

 

図 9 タイムポジションプロット 

 

 

図 10 タイムベースラインプロット 

 

【補足】 

SBAS処理では通常、コネクショングラフ内で線が繋がっているペアが使用されますが、軌道間距

離(Normal Baseline)が広すぎる場合や、観測日の間隔が長くあいている場合などは、コネクショ

ングラフが繋がらないことがあります。その場合、Normal Baselineと Temporal Baselineのパラ

メータ調整を行い、コネクショングラフを繋げる方法もあります。軌道間距離が広くコネクション

グラフが繋がらない場合は、ParametersタブにあるMax Normal Baselineの割合を増やすか、該

当データを除外することが考えられます。観測日の間隔によってコネクショングラフが繋がらない

場合は、Parametersタブにある Temporal Baselineの期間を大きくし、コネクショングラフが繋

がるように調整が可能です。ただし、期間を長く設定することにより画像全体のコヒーレンスが悪

くなり、その結果、干渉性も悪くなる可能性があります。Allow Disconnected Blocksパラメータ

を TRUEに設定することで、コネクションがつながっていないものをつなげることも可能です。

このパラメータでは、データ期間中に低コヒーレンスで通常処理に使用しないものも含めて処理を

行い、最終結果のカバレッジを上げるという目的も含まれます。  
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干渉画像作成処理 

SBASを実行する際の二つ目の必須ステップです。このステップでは、自動的にコネクショングラ

フで決定した干渉ペアデータの処理を行います。 

干渉画像作成処理では以下の処理が実施されます。 

⚫ インターフェログラム生成（コレジストレーション） 

⚫ コヒーレンス画像作成と干渉画像のフィルタリング 

⚫ フェーズアンラッピング 

処理が終了すると、auxiliary.smlが保存されているフォルダへ interferogram_stackingフォルダ

が作成され、処理結果はこのフォルダに格納されます。 

 

【操作】 

1. ENVIツールボックス → SARscape → Interferometric Stacking → SBAS → 2 - 

Interferometric Process を選択し、ワークフローダイアログを起動してください。 

 

 

図 11 干渉画像作成設定ダイアログ 

 

2. Input Filesタブ → Auxiliary Fileの横にあるフォルダマークをクリック → ファイルの選択

ダイアログ → コネクショングラフで出力された auxiliary.smlファイルを選択 → 「開く」を

クリックしてください。 
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図 12 auxiliaryファイル選択ダイアログ 

 

3. Optional Filesタブでは以下のオプションファイルが指定可能です。本手順ではいずれも使用

しません。 

 

 

図 13 Optional Files の設定ダイアログ 

 

Optional Filesタブのオプションファイルについて簡単な説明を以下へ記載します。 

表 3 干渉画像作成処理 Optional Files の項目一覧 

オプション名 内容 

Geometry GCP File 衛星の軌道の不正確さを修正するために使用することが

可能です。 

Avoid Moving Area File 変動があったエリアをマスクして処理をすることが可能

です。参照 DEMと同じ地図投影法のシェープファイルを

使用しエリアを指定しください。大きな地震があったエ

リア等、画像内で位相への影響が大きく解析できない場

合等に有効です。 

Optional Water Vapour File List 大気補正に使用するファイルが指定可能です。大気補正

を使用する場合は、GACOS(http://www.gacos.net/)から

ダウンロードしたファイルを SARscapeへインポートし、

本ダイアログで指定します。Parameters タブの
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オプション名 内容 

「Atmosphere External Sensors」を併せて設定してくだ

さい。 

Classification Mask File SBAS処理中に特定のエリアをマスクして処理することが

可能です。クラス IDは数字(1, 2, 3…)でラベル付けさ

れ、地理座標がついたラスタファイルを指定してくださ

い。マスクファイルは事前に SARscapeへインポートする

必要があります。 

 

4. 次に、DEMの設定を行います。DEM/Cartographic System タブ → DEM Fileの横にあるフ

ォルダマークをクリック → ファイルの選択ダイアログから、DEMファイルを選択 → 「開

く」をクリックしてください。SARscapeで使用する DEMは SARscapeフォーマットファイ

ルで、楕円体高である必要があります。 

 

 

図 14 DEM選択タブ 

 

5. DEMが用意されていない場合は、同じダイアログ画面の双眼鏡アイコン をクリックします。

ダウンロードする DEMを選択して緑色のチェックマークをクリックすると、DEM Extraction

ツールが起動し、インターネット上に公開されている DEMをダウンロードすることができま

す。今回用意されている DEMは、SRTM-3 Version4をダウンロードしたものです。ダウンロ

ードしたデータは楕円体高に変換されています。 

 

 

図 15 ダウンロードする DEMの選択ウィンドウ 
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6. その他の設定値を変更する場合は、Parametersタブで設定を行います。データの条件などが異

なる場合は設定が必要になる場合がありますが、基本はデフォルトのままで問題ありません。

値を変更せずに実行します。 

 

 

図 16 Parametersタブ設定 

 

Parametersタブの Principal Parameters について簡単な説明を以下へ記載します。 

表 4 干渉画像作成処理のパラメータ 

パラメータ名 内容 

Rebuild All このフラグを設定すると、全てのデータを使用し最初から再処理

を行います。一度処理を実行した後にパラメータなどの変更を

し、再度処理を実施しなおす場合は、Trueにして実行します。

既に処理済みのデータに対して、新しいデータを追加して処理す

る場合は、False を設定します。 

Range/Azimuth Looks レンジ・アジマスのルックス数を設定します。デフォルト値は、

Preference Specific 設定でセンサに合ったルックス数が入力さ

れています。 

Grid Size for Suggested 

Looks 

解像度(m)を設定します。デフォルト値は、ルックスに合った解

像度が入力されています。 

Redundancy Criteria 上記を Lowに設定した際に余剰コネクションを削減するための基

準を選択します。 

Number of Parallel 

Unwrapping 

CPUスレッドの総数を超えない程度で並行処理するアンラッピン

グ処理の数を定義します。メモリ消費は並行処理に直接関係しま

すので設定変更前にシステムメモリを十分考慮する必要がありま

す。 

Apply Layover and Shadow 

Mask 

結果のレイオーバ＆シャドー領域をマスクします。 
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パラメータ名 内容 

Atmosphere External Sensors GACOSや MERIS(ENVISATのみ)の外部センサを用いて大気効果を

除去します。外部レイヤは事前のダウンロードおよびインポート

が必要です。 

Atmosphere Height 

Correlation Flag 

高度に相関する大気効果成分を推定し除去します。このフラグ

は、標高と強く相関がある大気効果を持つ山岳地帯向けです。 

Coregistration with DEM Trueの場合、コレジストレーション処理時に DEMを参照しま

す。 

Unwrapping Method Type アンラッピングの手法を Region Growing、Minimum Cost Flow、

Delaunay MCFから選択できます。 

Unwrapping Decomposition 

Level 

アンラッピング処理前のアンダーサンプリングレベルの数値を指

定します。 

Unwrapping Coherence 

Threshold 

アンラッピングの際にこの値より低い全てのピクセルがマスクさ

れます。 

Filtering Method フィルタリングの手法を Goldstein、Adaptive window、

Adaptive Non-Local InSAR、Boxcar windowから選択できます。 

 

7. 「Exec」ボタンをクリックし、処理を実行してください。 
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速度推定(1 回目) 

ここでは、変動速度と高さの残差位相を算出するため、1回目の速度推定を実施します。インター

フェログラムを平坦化し、位相のアンラッピングとリファインメントを再実施します。

SARscape5.6.2から平坦化のための GCP取得は内部処理で自動化されており、Refinement and 

Reflatteningステップは無くなり、手動取得の必要は無くなりました。 

 

【操作】 

1. ENVIツールボックス → SARscape → Interferometric Stacking → SBAS → 3 - Inversion 

First Stepを選択し、ダイアログを起動してください。 

 

2. Input Filesタブ → Auxiliary Files の横にあるフォルダマークをクリック → ファイルの選択

ダイアログク → コネクショングラフで出力された Interferometric Processまで済んだ当該

SBAS処理の auxiliary.smlファイルを選択 → 「開く」をクリックしてください。 

 

 

図 17 速度推定(1回目)設定ダイアログ 

 

3. Optional Filesタブでは Refinement and Reflatteningに使用する GCPを指定することが可能

ですが、本チュートリアルでは使用しません。 

 

 

図 18 Optional Files タブ 

SARscape5.6.2から、SBAS処理の GCP取得は内部処理として自動化されており、

Refinement and Reflatteningステップは除外され手動 GCP取得の必要は無くなりました
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が、オプションで従前のように手動取得を指定することも可能です。その場合は、この 

Inversion First Stepの Optional Filesタブで Refinement and Reflattening 用の

Refinement GCP Fileを作成できますので SARscape5.6.0以前と同様の手法で 30点程度また

はそれ以上の GCPを有効ピクセル上に指定してください。（巻末の「補足：手動で GCPを

取得する手順」参照） 

 

4. Parametersタブは変更せず、処理を実行させるため「Exec」ボタンをクリックしてくださ

い。 

 

 

図 19 Parametersタブ 

 

Parametersタブの Principal Parameters について簡単な説明を以下へ記載します。 

表 5 速度推定(1回目)のパラメータ 

パラメータ名 内容 

Rebuild All 再処理をする場合の、処理実施の程度を設定できます。Falseに

すると、処理中断などが発生した場合の再処理で既に処理済みの

データを再処理せずに済みます。Trueにするとファーストイン

バージョン処理を全てのデータを使用し、再処理を行います。一

度処理を実行した後にパラメータなどの変更をし、再度最初から

処理を実施したい場合は、Trueにして実行します。 

Product Coherence Threshold コヒーレンス値がこの閾値より小さい値を持つピクセルは、結果

画像でダミー(NaN)値が設定されます。 

Displacement Model Type 速度推定に適用する変動モデルを指定できます。Linear、

Quadratic、Cubic、Linear Periodic、No Displacementから選

択します。 

Estimate Residual Height Trueの場合、残差地形の高さを推定します。高解像度の DEMを

使用している場合や、20枚未満の画像を使用している場合、こ

のオプションの使用は推奨されません。 
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パラメータ名 内容 

Spatial Wavelet Size (m) 参照 DEMを設定値の解像度まで低解像度化し、残差地形成分を推

定し、それ以外の歪みに対してウェーブレット分解を実施しま

す。 

Allow Disconnected Time 

Series 

取得したデータの一部がメインのコネクションに含まれず、別の

コネクションになっている場合は、このオプションを有効にする

ことで時間的間隔が開いた別のコネクションも変動の算出に追加

することが可能です。下にある Min Valid Interferograms ％の

閾値のもとでより広い解析範囲を提供します。 

Min Valid interferograms % このパラメータは各出力グリッドポイントでの有効なインターフ

ェログラムの最小数の割合を表します。 

Stop Before Unwrapping Trueに設定した場合、最後のフェーズアンラッピング処理は実

行されません。 

Number of Parallel 

Unwrapping 

CPUスレッドの総数を超えない程度で並行処理するアンラッピン

グ処理の数を定義します。メモリ消費は並行処理に直接関係しま

すので設定変更前にシステムメモリを十分考慮する必要がありま

す。 

Unwrapping Method Type アンラッピングの手法を Region Growing、Minimum Cost Flow、

Delaunay MCFから選択します。 

Unwrapping Decomposition 

Level 

アンラッピング処理前のアンダーサンプリングレベルの数値を指

定します。 

Unwrapping Coherence 

Threshold 

アンラッピングの際にこの値より低い全てのピクセルがマスクさ

れます。 

Refinement Radius (m) GCPを近傍の有効ピクセルと関連付けるバッファ半径です。 

Refinement Res Phase Poly 

Degree 

位相平坦化の際の位相傾斜推定に用いる多項式の次数。デフォル

ト値の 3はレンジおよびアジマス方向の位相傾斜と一定の位相オ

フセットが補正されることを意味します。位相オフセット補正の

みが必要な場合、多項式の次数は 1に設定できます。また、入力

された GCP数よりも次数が大きい場合は自動的に次数を減少しま

す。 

 

5. 処理が終了すると、出力フォルダ配下の first_inversionフォルダへ処理結果が含まれたメタフ

ァイルなどが出力されます。出力されたメタファイルの FI_model_metaファイルには初期速

度推定画像（FI_velocity）などが含まれます。その他、interf_tiffと inversionというサブフォ

ルダが作成され、それぞれこの処理で実施された干渉処理のクイックルック用 TIFFファイル

とスラントレンジジオメトリデータが出力されています。閲覧用ではない ENVIフォーマット

の実データは work フォルダ配下に格納されています。 
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図 20 Data Manager内の出力ファイル 
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速度推定(2 回目) 

2回目の速度推定処理です。ここでは、前処理で取得した最適化されたアンラップ画像を使用し、

再度変動速度や残差高さの推定を行い、これらの推定された位相を観測した位相から取り除き、大

気やその他の影響による位相を推定して、ノイズとして除去します。ここでも SARscape5.6.2か

ら平坦化のための GCP取得は内部処理で自動化されており、手動取得の必要はありません。 

 

【操作】 

1. ENVIツールボックス → SARscape → Interferometric Stacking → SBAS →     4 - 

Inversion Second Step を選択し、ワークフローダイアログを起動してください。 

2. Input Filesタブ → Auxiliary Files の横にあるフォルダマークをクリック → ファイルの選択

ダイアログ → コネクショングラフで出力された Inversion First Stepまで済んだ当該 SBAS

処理の auxiliary.smlファイルを選択 → 「開く」をクリックしてください。 

 

 

図 21 速度推定(2回目)ダイアログ 

 

3. Optional Filesタブでは Refinement and Reflatteningに使用する GCPを指定することが可能

ですが、本チュートリアルでは使用しません。 

 

図 22 Optional Files タブ 

SARscape5.6.2から、SBAS処理の GCP取得は内部処理として自動化されており、

Refinement and Reflatteningステップは除外され手動 GCP取得の必要は無くなりました
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が、オプションで従前のように手動取得を指定することも可能です。その場合は、この 

Inversion First Stepの Optional Filesタブで Refinement and Reflattening 用の

Refinement GCP Fileを作成できますので SARscape5.6.0以前と同様の手法で 30点程度また

はそれ以上の GCPを有効ピクセル上に指定してください。（巻末の「補足：手動で GCPを

取得する手順」参照） 

 

4. Parametersタブの値の変更はありません。処理を実行させるため、「Exec」ボタンをクリッ

クしてください。 

 

 

図 23 Parametersタブ 

 

Parametersタブの Principal Parameters について簡単な説明を以下へ記載します。 

表 6 速度推定(2回目)のパラメータ 

パラメータ名 内容 

Rebuild All 再処理をする場合の、処理実施の程度を設定できます。Falseに

すると、処理中断などが発生した場合の再処理で既に処理済みの

データを再処理せずに済みます。Trueにするとファーストイン

バージョン処理を全てのデータを使用し、再処理を行います。一

度処理を実行した後にパラメータなどの変更をし、再度最初から

処理を実施したい場合は、Trueにして実行します。 

Product Coherence Threshold コヒーレンス値がこの閾値より小さい値を持つピクセルは、結果

画像でダミー(NaN)値が設定されます。 

Interpol Disconnected Time 

Series 

このパラメータを Trueに設定すると、変動結果が算出されてい

ない部分に対して線形内挿の変動測定値を推定します。算出され

ていないギャップ前後の測定値から推測されるため、信頼性は慎

重に評価してください。このパラメータの下にある(Min Valid 

Interferograms %、Min Valid Acquisitions %)パラメータを使

用し、ギャップ間の変動を推定します。 



 

20 

パラメータ名 内容 

Min Valid interferograms % このパラメータは各出力グリッドポイントでの有効なインターフ

ェログラムの最小数の割合を表します。 

Min Valid Acquisitions % このパラメータは各出力グリッドポイントでの有効な取得データ

の最小数の割合を表します。 

Atmosphere Low Pass Size (m) 大気変動の空間的由来分布のウィンドウサイズを設定します。設

定値が小さいと局所的な変動の補正に適し、大きいと広域な変動

を補正することに適しています。 

Atmosphere High Pass Size 

(days) 

大気変動の時間的由来分布のウィンドウサイズを設定します。頻

繁発生している大気変動を補正するには設定が小さい方が適して

います。一時的な変動が少ない場合は設定値が大きい方が適して

います。 

Refinement Radius (m) GCPを近傍の有効ピクセルと関連付けるバッファ半径です。 

Refinement Res Phase Poly 

Degree 

位相平坦化の際の位相傾斜推定に用いる多項式の次数です。デフ

ォルト値の 3はレンジおよびアジマス方向の位相傾斜と一定の位

相オフセットが補正されることを意味します。位相オフセット補

正のみが必要な場合、多項式の次数は 1に設定できます。また、

入力された GCP数よりも次数が大きい場合は自動的に次数を減少

します。 

 

5. 処理が終了すると、出力フォルダ配下の second_inversionフォルダへメタファイルなどが出力

されます。出力されたメタファイルの SI_model_metaファイルには平均変動速度画像

（SI_velocity）などが含まれます。 

 

 

図 24 Data Manager内の出力ファイル 
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ジオコーディング 

算出された結果に地理情報を付与し、ラスタやシェープファイルに保存します。 

ここで Optional Filesで指定することができる Refinement GCPファイルは、Inversionステップ

の GCPとは異なり不動点を示すものです。こちらもデフォルトで自動取得が可能ですが、必要で

あれば手動で 1点～3点程度設定することも可能です。 

 

【操作】 

1. ENVIツールボックス → SARscape → Interferometric Stacking → SBAS →    5 - 

Geocoding を選択し、ダイアログを起動してください。 

2. Input Filesタブ → Auxiliary Files の横にあるフォルダマークをクリック → ファイルの選択

ダイアログク → コネクショングラフで出力された Inversion Second Step まで済んだ当該

SBAS処理の auxiliary.smlファイルを選択 → 「開く」をクリックしてください。 

 

 
図 25 ジオコーディングダイアログ 

 

3. Optional Filesタブでは任意で Refinement and Reflatteningまたは固定(不動)点の設定が可能

ですが、本チュートリアルでは使用しません。 

 

図 26 Optional Files タブ 

不動点をユーザ自身で設定したい場合は、手動で GCP設定を実施できます。Optional Files

タブの Refinement GCP Fileの横にある双眼鏡マーク をクリック → Generate Ground 
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Control Pointsダイアログを起動し、GCPを作成するためのファイルを選択し、GCPを 1~3

点程度設定します。1点の GCPは不動参照点のみ、2点以上になると、不動点かつ

Reflattening処理に使用します。 

 

4. DEMの設定を行います。DEM/Cartographic Systemタブ → DEM Fileの横にあるフォルダ

マークをクリック → ファイルの選択ダイアログから、DEMファイルを選択 → 「開く」を

クリックしてください。出力データの投影法は DEMの投影法を使用しますが、DEMを使用し

ない場合 Output Projectionsにて投影法を指定します。 

 

 

図 27  DEM設定タブ 

 

5. Parametersタブの値の変更はありません。処理を実行させるため、「Exec」ボタンをクリッ

クしてください。 

 

 

図 28 Parametersタブ設定項目 

 

Parametersタブの Principal Parameters について簡単な説明を以下に記載します。 
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表 7 ジオコーディングのパラメータ 

パラメータ名 内容 

Rebuild All 再処理をする場合の、処理実施の程度を設定できます。Falseに

すると、処理中断などが発生した場合の再処理で既に処理済みの

データを再処理せずに済みます。Trueにするとファーストイン

バージョン処理を全てのデータを使用し、再処理を行います。一

度処理を実行した後にパラメータなどの変更をし、再度最初から

処理を実施したい場合は、Trueにして実行します。 

Height Precision Threshold 高さ推定に対する平均精度の上限の閾値を設定します。単位はメ

ートルです。 

Velocity Precision Threshold 変動速度推定に対する平均精度の上限の閾値を設定します。単位

は mm/年です。 

Product Temporal Coherence 

Threshold 

設定した閾値以下の時間的コヒーレンス値を持つピクセルは、ダ

ミー(NaN)値が設定され出力されます。 

Water Mask (dB) 平均強度画像から水域マスクを作成する目的で使用します。単位

は dBです。設定した閾値以下のピクセルにマスクが設定され出

力されます。 

Make Geocoded raster Trueに設定すると、ラスタ形式のファイルを出力します。 

Make Geocoded Shape Trueに設定すると、シェープ形式のファイルを出力します。 

Shape Max Number of Points -1以外の数字が入力されている場合、有効になります。設定値

を超える数の点を含むシェープファイルを分割して保存します。 

Generate Shape Time Series 時間に伴う変動をシェープ形式のファイルで出力します。 

Generate Shape Counter 

Series 

取得日ごとに有効な干渉カウンタを含むシェープ形式のファイル

で出力します。 

Vertical Displacement 視線方向の変動を垂直方向への移動と仮定した変化量を出力しま

す。 

Slope Displacement 視線方向の変動を最大傾斜方向への移動と仮定した変化量を出力

します。 

Displacement Custom 

Direction 

Trueに設定すると、任意のベクトル方向への移動と仮定した変

化量を出力します。Azimuth Angle(北からの角度で時計回り方向

を指定)と Inclination Angle(水平面からの角度で傾斜角を指

定)が有効になります。 

X Dimension (m) X(東)方向のグリッドサイズの目安を定義します。単位はメート

ルです。地図投影法の場合、0.2以上の数値はメートル単位とし

て扱い、メートルから度に変換されます。それ以下の場合は、度

として扱い、変換なしで使用されます。 

Y Dimension (m) Y(北)方向のグリッドサイズを定義します。単位はメートルで

す。 
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パラメータ名 内容 

Mean Window Size 高さ推定画像に対して実行する平均値フィルタのウィンドウサイ

ズを設定します。値が 0の場合、フィルタ処理は実行されませ

ん。フィルタ処理は補間処理後に実施されます。 

Interpolation Window Size 出力ファイルのダミー値を補間します。補間値は指定したサイズ

のウィンドウ内の有効値の平均です。値が 0の場合、補間は実行

されません。 

Refinement Radius (m) GCPを近傍の有効ピクセルと関連付けるバッファ半径です。 

Refinement Res Phase Poly 

Degree 

位相平坦化の際の位相傾斜推定に用いる多項式の次数です。デフ

ォルト値の 3はレンジおよびアジマス方向の位相傾斜と一定の位

相オフセットが補正されることを意味します。位相オフセット補

正のみが必要な場合、多項式の次数は 1に設定できます。また、

入力された GCP数よりも次数が大きい場合は自動的に次数を減少

します。 

 

6. 結果を表示(load)するか聞かれますので、ENVIへと表示してください。G_disp_geo_metaフ

ァイルは地理情報が付与された変動速度の値を持ったデータです。日付ごとの変動と

G_SI_velocity_geo以外の他データも含まれています。手動で読み込みを行う場合は、以下のフ

ァイルを ENVIで開いてください。 

 

指定出力先フォルダ¥geocoding¥G_disp_geo_meta 

 

 

図 29 データマネージャ内の出力ファイル 

 

7. 結果を確認します。データマネージャ → G_disp_geo _metaファイルの G_SI_velocity_geoの

バンドを選択 → 右クリックし、Load Grayscaleを選択します。表示されたデータを Layer 

Managerで右クリック → Change Color Table → Rainbowを選択してください。 
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図 30 変動速度データの読み込み 

 

 

図 31 疑似カラーを付与した結果の表示 

 

8. カーソルで指定したピクセル値のグラフを表示します。ENVI ツールボックス → SARscape 

→ General Tools → Time Series Analyzer → Rasterを選択し、確認したい場所へカーソル

を移動し、「Plot」ボタンをクリックすることで、任意のポイントの時系列の変動を確認する

ことができます。 
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図 32 特定地点の時系列変動プロットの表示 
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補足：手動で GCP を取得する手順 

Refinement and Reflattening用の GCP取得が内部処理により自動化されましたが、First、

Second Stepで各々Reflattening用に、そして Geocodingで不動参照点適用向けに Optional Files

タブで従前どおりの手順で手動 GCPを取得することも可能です。 

ここではユーザ自身で Reflattening処理で使用する GCPを作成したい方向けに手動 GCP取得の

手順を示します。GCPはノイズ除去と軌道補正の設定を目的としています。GCPの配置は、変動

のエリアは避け、コヒーレンスが高く有効な（アンラッピング画像上に存在する）ピクセルを目安

に、画像全体に 30点程度またはそれ以上取得します。 

 

【操作】 

1. 3 - Inversion: First Step の Refinement GCPを例にあげます。Optional Filesタブを選択し、

Refinement GCP File の横にある双眼鏡マーク をクリック → Generate Ground Control 

Pointsダイアログを起動します。GCPを作成するためのファイルを選択し、Nextをクリック

します。 

 

 
図 33 Refinement and Re-flattening設定ダイアログ 

 

2. Generate Ground Control Points ダイアログが起動します。コヒーレンスが高く、変動のない

ところに 30点程度またはそれ以上取得します。入力指定ファイルは

work¥work_interferogram_stackingフォルダ内の同ベースファイル名の揃いのファイルであ

ればユーザ任意で、細かい指定はないのですが、この説明では干渉画像の_upha画像に対し

て、コヒーレンスの_cc画像を参考に GCPを取得します。ただし、*_meta ファイルのような

メタファイルを指定すると動作しませんので、_fint, _upha, _pwr, _ccなどの実体ファイルを指

定するようにご注意ください。 
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図 34 GCP作成に使用するファイル設定ダイアログ 

 

表 8 GCP作成ツールの項目一覧 

パラメータ名 内容 

Input File GCPを設定する位置を示すファイル 

上記設定ファイルは出力ファイルパス

\work\work_interferogram_stacking 内にある*_upha

画像を使用します。 

DEM File GCPの高さを示す DEMファイル 

設定ファイルは Interferometric Processingでも使用

した DEMファイルです。 

Reference File GCPを設定するために参考とするファイル 

ファイル選択は任意ですが、上記 Input File と同名ベ

ースファイルで出力ファイルパス

\work\work_interferogram_stacking 内にある*_cc 画

像を使用します。 

 

※以下フォルダに、使用するデータの各ペアで導出された_fint、_upha、_ccの閲覧用クイックル

ックファイルがあるので、フォルダ内の画像のサムネイル表示や、windowsの画像ビューワで簡単

に画像を確認することが可能です。クイックルックファイルを参考にどのファイルを使用すれば良

いかデータを確認し、決定することが可能です。 

クイックルックファイル: 出力ファイルパス¥interferogram_stacking¥interf_tiff 

 

3. GCP作成用のデータが ENVIへ表示された後、各画像のデータ値が認識しやすくなるように、

_upha画像と_cc画像へ疑似カラーを付与します。 
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4. Layer Manager→_upha画像を右クリック→Change Color Tables→Rainbow を指定し、さら

に見やすいようにストレッチングをかけて画像を強調表示します。同じ操作を_cc画像にも行っ

てください。 

 

 

図 35 左図: _upha画像  右図: _cc画像 

 

5. ENVIのツールバーにある、Transparency ツールを使用し、下の_cc画像が参照出来るよう、

透過度を変更します。画像全体に、_upha画像のインターフェログラム画像で位相が安定して

いて、コヒーレンスの値が高い箇所に対して、任意の数だけ GCPを設定し、Finishをクリッ

クします。 

 

 

図 36 左図: 設定した GCP  右図: GCP作成ダイアログ 
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6. GCPの処理が終了すると出力フォルダ直下へファイルが作成されています。また、出力された

ファイルは自動的に Optional Files タブの Refinement GCP Fileへと設定されています。当該

ステップの他の設定を実施して Execをクリックして処理を開始します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

お問い合わせ先 

本チュートリアルに関する、ご質問やご要望に関しましては以下のメールアドレスまでご連絡をお

願いいたします。 

NV5 Geospatial 株式会社 

サポート窓口： 

support_jp@NV5.com 


